
Presenting Adobe Premiere Elements 2.0, with everything you need to create home videos to thrill 
friends and family. The perfect combination of superior control, ease of use, and reliability, Premiere 
Elements 2.0 automates tedious tasks so you can be creative more quickly. Import video clips from all 
of your digital video devices, then experiment with hundreds of professional transitions and effects to 
grab your audience. Burn your videos to DVD, complete with custom menus for that personal touch, 
or output them for the Web, VHS and Windows Mobile-based media players, to wow your audience 
anywhere.

Before You Begin

Installation

Insert the Adobe Premiere Elements 2.0 DVD and follow the instructions in the Setup application 
to copy all relevant files to your hard drive. Then copy the Sample Files folder from the DVD to your 
desktop. The Sample Files folder contains the video clips, graphics and sound files you’ll be working 
with throughout this guide.

What you’ll need

Adobe Premiere Elements 2.0 is your complete end-to-end home video solution. Using the supplied 
sample files, you can become familiar with its comprehensive, easy-to-use features. But for the 
complete Adobe Premiere Elements 2.0 experience, you might want to have available:

Digital camcorder (MiniDV or Digital8) with IEEE 1394 (i.LINK/FireWire) cable, or digital 
camcorder with DV-via-USB compatibility and USB2 cable, and ports to connect the camera to 
your computer.
DVD camcorder, digital still camera, and other devices with video capability, such as camera-
equipped mobile phones.
Windows-based computer meeting the system requirements on the last page of this guide, 
including at least one available IEEE 1394 or USB2 connection port, as applicable.
DVD writer attached to your computer.
TV monitor with cables to connect it to your DV camcorder, for live TV previewing.

What you won’t need

Any additional capture, editing, graphics, audio, DVD menu creation or DVD recording software. 
Adobe Premiere Elements 2.0 is the only software you need to turn raw digital footage from all your 
video devices into a finished DVD movie—quickly, easily, and enjoyably.
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Getting Ready—Shooting Your Video
If you’re short of time, you can just read through the first two sections of this Reviewer’s Guide and 
get hands-on in the third section, Action!—Editing Your Video, using the supplied sample clips. 
However, to really get to know everything Adobe Premiere Elements 2.0 is capable of doing for you, 
we recommend starting at the very beginning—shooting your video.

Shoot about 10 minutes of new footage with your DV camcorder. Be sure to include at least five 
individual scenes—in other words, five separate starts and stops in recording.
After the second or third scene, stop your DV camcorder, rewind the tape a little, and preview 
the footage you just shot, using the DV camcorder’s screen or viewfinder. Then fast forward back 
to the end and shoot the rest of your scenes. You’ll see in a few minutes how Adobe Premiere 
Elements 2.0 handles the timecode gap you will have created.

Getting Started—Capture Your Video
In every step, Adobe Premiere Elements 2.0 combines easy automation with creative control. This 
means taking care of the mundane moviemaking tasks for you, so you can concentrate on the fun 
part of creating your own cinematic gems.

With your DV camcorder turned OFF, attach it to 
your computer with the appropriate cable. Then turn 
on the camera in its player or VCR/VTR mode. 
If the computer is off, turn it on now. Windows XP 
should recognize your DV camcorder and offer to set 
a preference for the application to use with it. Choose 
Adobe Premiere Elements 2.0 and click OK. Premiere 
Elements 2.0 should launch immediately and open the 
Welcome Screen.
Click the Capture Video button, enter “My First 
Movie” as the project name, and click OK to open the 
Capture workspace.
The Capture panel has controls to operate your DV 
camcorder directly from the computer, and also tells 
you roughly how much video you can capture, based 
on the free space on your hard drive.
Click the DV camcorder controls to play some of 
your tape in the Capture panel. The controls work 
in exactly the same way as the play, fast forward and 
rewind buttons on your DV camcorder itself. Use the 
Jog control under the Play button  to finely control 
searching backwards and forwards through the tape. 
Use the Next and Previous Scene buttons  to 
jump directly to the next or previous point where 
you started recording. When you’re done testing the 
controls, click the Rewind button  and return to 
the start of the tape.
Click the Capture button. Premiere Elements 2.0 
begins transferring your video, a process which takes 
exactly as long as the amount of time recorded. 
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The Capture panel
Status—Including estimated recording time on your hard drive
Preview window—View your footage before and during transfer
Capture button—One click captures all video from your DV 
camcorder
DV Camcorder controls — Remotely control your DV camcorder
Next/Previous scene — Skip forwards and backwards through the 
scenes on your DV camcorder tape with a simple mouse click
Jog control — Smooth, variable slow and fast motion, in both 
directions

A 
B 
C 

D 
E 

F 

A

B

C

D

FE

The Capture panel
Status—Including estimated recording time on your hard drive
Preview window—View your footage before and during transfer
Capture button—One click captures all video from your DV 
camcorder
DV Camcorder controls — Remotely control your DV camcorder
Next/Previous scene — Skip forwards and backwards through the 
scenes on your DV camcorder tape with a simple mouse click
Jog control — Smooth, variable slow and fast motion, in both 
directions

A 
B 
C 

D 
E 

F 



�

If you watch the Clip Name field, you will see the number change as individual clips are created. 
Here is why we asked you earlier to shoot your video in a particular fashion. As Adobe Premiere 
Elements 2.0 captures your footage, Scene Detect watches for the moments where you stopped 
and restarted recording, and creates new scenes at those points. And if you have used other video 
software in the past, you may also notice something different when Premiere Elements 2.0 gets to 
the blank spot that you created by reviewing footage in the DV camcorder. Instead of assuming it’s 
finished and stopping, it looks past the timecode gap, finds the additional footage, and continues. 
That means you don’t have to baby-sit your capture. Instead, you can simply let Adobe Premiere 
Elements 2.0 work unattended, capturing all your footage, breaking it into appropriate scenes, and 
inserting them all on the Timeline, in order, ready for editing.

Transfer video from other devices

For virtually every video device besides your DV 
camcorder, the new Media Downloader makes 
it simple to transfer video to your computer. 
From your set top recorders, digital still 
cameras, mobile phones and video hybrid 
devices, all you need is a USB or FireWire 
cable, or the appropriate CD or DVD 
drive on your computer.

Connect a non-DV device to your 
computer, or insert an unprotected 
DVD video disc in your DVD drive.
Press the Add Media button and 
choose From DVD Camcorder or 
Removable Drive.
In the Media Downloader, select the 
device or drive in the “Get Media 
From” pop-up menu. Under Save Files, 
select a location to save the transferred 
video. You can also optionally set the Media Downloader to automatically create and place the 
files in subfolders, and to rename the files using your preferred naming scheme.
Select the files you want to download by selecting check boxes in the preview area. Note you can 
also transfer still images and sound files at the same time if the device contains them.
Click Get Media to start the transfer. It’s important to use the Media Downloader to copy the 
media to your computer, so that you don’t have to reinsert source DVDs or other removable 
media later, when you work with the media on the Timeline.

If you have Adobe Photoshop Elements 4.0 installed on your computer, the Photo Downloader window 
may appear before the Premiere Elements 2.0 Media Downloader. While these two windows appear 
very similar and perform similar functions, the Photo Downloader is not compatible with as many video 
formats as the Media Downloader. For this reason, we recommend you close the Photo Downloader if it 
appears, and use the Media Downloader to transfer media for use in Premiere Elements 2.0.
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Supported Formats
Premiere Elements 2.0 
supports the import of 
most multimedia file 
formats, including:

Video
3GP/3GPP2  
(mobile phones)
ASF 
AVI
DV
DVD (.vob)
MOD (JVC Everio)
MPEG-1
MPEG-2
MPEG-4
QuickTime 
Windows Media

Audio
AIFF
AVI
Dolby (AC3)
MP3
QuickTime
WAV
WMA

Still Graphics
BMP 
JPEG
PSD
TIFF
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Action! — Editing Your Video
Once the video transfer is complete, click the Edit button on the navigation bar and take a look at the 
main editing panels and tools in Adobe Premiere Elements 2.0, starting with the new, self-adjusting, 
task-driven workspace. Each part of the video process has its own standard panel arrangement, 
which you can easily adjust to suit your own preferences. Need to zoom in on the action? Increase 
the Monitor panel size and watch the other panels automatically adjust to fit the space. You’ll never 
lose track of a panel or lose time opening and closing to find the panels you need.

Move the mouse to the border between any two panels. 
When the pointer changes to a two-sided arrow ( ), 
drag the horizontal border up or down, or the vertical 
border left or right. As you adjust the size of one panel, 
the panels adjacent to it adjust automatically to make 
room or fill the space.
Drag any panel by its tab and move it into the center 
of any other panel. When the target grid appears, drop 
the panel into one of the side areas to create adjacent 
panels, or drop it into the center area to add the panel 
you are dragging to the target panel as a new group.
Click one of the buttons on the navigation bar to 
instantly arrange the panels you need in the most 
commonly used arrangement. If you adjust the panels, 
your custom arrangement is remembered, and will 
be restored the next time you click that button on the 
navigation bar.
To restore the default panel arrangements for any 
workspace, choose a command from the Window > 
Restore Workspace submenu.
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Drag a panel by its tab into another panel 
to show the docking template, then drop it 
in the outside areas (1-4) to dock it above, 
below or to either side of the target panel. 
Drop it in the center area (5) to dock it with 
the target panel as a new group.
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Drag a panel by its tab into another panel 
to show the docking template, then drop it 
in the outside areas (1-4) to dock it above, 
below or to either side of the target panel. 
Drop it in the center area (5) to dock it with 
the target panel as a new group.

C

D

The new Premiere Elements 2.0 workspace 
makes creating your next movie easier and 
more fun.

A.	Find the right effect or transition more 
easily with visual previews in the Transition 
and Effects panel.

B.	 Drag at the border of any two panels 
and let the self-adjusting workspace resize 
the others automatically.

C.	Switch between task-oriented panel 
arrangements with one click in the 
Navigation Bar.

D.	Easily adjust the options for any 
element in the context-sensitive 
Properties panel. 
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Easy editing

Media—The Media panel displays all the files you can use in your project, with a column telling 
you how clips are already used in the Timeline. Clips are more than just video—they include 
scenes, sound files, still images, titles—everything you need, right under your fingertips.
Monitor—This panel lets you play the Timeline or clips from the Media window.
Timeline—The nerve center of Adobe Premiere Elements 2.0. Here is where you edit your scenes, 
add extra video and audio tracks, create transitions and effects, mix audio—everything that turns 
your raw DV camcorder tape into a polished, complete video.
Effects and Transitions—Docked with the Media panel by default, this contains all of the special 
effects and transitions you use to turn plain old video into your own Hollywood movie.

The Edit workspace starts with Media, Monitor, and Timeline displayed, but you can rearrange the 
panels as you wish, and your custom arrangement will be remembered the next time you click the 
Edit button in the navigation bar.

Now that you’ve seen how simple capturing your video is with Adobe Premiere Elements 2.0, it’s 
time to edit your video. While you could certainly continue with the footage you just shot and 
transferred, you will probably find it simpler to use the supplied sample files, since they match 
the text and illustrations in the rest of this Reviewer’s Guide. You can save your current project, 
containing your own footage, and come back to it later at your leisure.

Choose File > Open > Project. Select the file Reviewer’s Guide.prel in the Sample Files folder on 
your desktop, then click ‘Yes’ to save your imported video in the project you already had open.
The Reviewer’s Guide project opens in the Edit workspace, with all the files we’ll need for the 
following examples.
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Trims and splits—your first edits

You should now be looking at the Timeline as it would appear if you had just captured a DV 
camcorder tape from a vacation trip to San Francisco—all of your clips assembled in chronological 
order. You could actually move straight to burning a DVD at this point, but usually you will at least 
want to cut some shots down, and add a few transitions and titles. So let’s make a video.

Click the Play button  in the Monitor panel or press the spacebar on your keyboard to watch 
the entire set of clips captured from “your” DV camcorder. That gives you an idea of the flow of 
your footage, so you can start thinking about what you want to create with it.
To move quickly around the Timeline, use the scroll bars to adjust your view, and click in the 
time graph area to immediately move the playhead  (also called the current-time indicator) 
to that point. For smaller movements, drag the playhead itself. Move the playhead now to the 
beginning of clip 02.avi on the Timeline. 
Click the Zoom In  button to expand the display of the clip, then play forward until the family 
comes into view. Drag the playhead back and forth slowly until you find the point where the 
shaky panning stops at the beginning. Then back the playhead off to the left a little.
Move the Selection tool  to the beginning of the clip on the Video 1 track, where the pointer 
becomes the Trim cursor ( ). Drag to the right to trim the front off the clip. The edit line snaps to 
the playhead when you get there—release 
the mouse to complete the trim. Drag the 
playhead to the beginning of the Timeline 
and press Play to see your new clip.

Next, move the playhead to the clip 24.avi for a slightly different kind of cut. If you play the clip, 
you’ll see a point where the camera pans from shooting behind the go kart to shooting forwards. 
To remove only the pan, we’ll use the new Split Clip button.
Move the playhead to the very start of the pan—about three seconds into the clip —and click the 
Split Clip button  just above the Timeline. 
You now have two clips—a short clip ending just before the pan, and a second clip beginning with 
it. Click the Selection/Trim tool again to re-enable it, then trim the pan from the beginning of 
the new second clip. Note as you trim the clip in the middle of the Timeline, the Monitor display 
splits to show you the changing edit point. When you finish trimming, Premiere Elements 2.0 
automatically reconnects the clips, instead of leaving a hole between the clips that you have to 
manually reconnect. 
Return to the start of 24.avi and press Play to see the clips without the pan in the middle.
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Don’t worry about 
trimming too much 
off a clip—you can 
undo your trim 
easily using the 
Undo command or 
the History panel, 
or even use the 
Trim tool to add the 
footage back on. 
This is because you 
are not changing 
the actual clips 
when you edit, 
merely telling 
Adobe Premiere 
Elements 2.0 how 
to use them on the 
Timeline.
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Simple, intelligent editing: As you drag to trim the head 
or tail of a clip, the pointer changes to show the tool 
being used, and to indicate the clip that is being affected. 
The footage time being trimmed appears in a Tool 
Tip, and the changing edit point is displayed in a split 
window in the Monitor panel.

Simple, intelligent editing: As you drag to trim the head 
or tail of a clip, the pointer changes to show the tool 
being used, and to indicate the clip that is being affected. 
The footage time being trimmed appears in a Tool 
Tip, and the changing edit point is displayed in a split 
window in the Monitor panel.

The Split Clip 
command acts 
simultaneously on all 
tracks in the Timeline. 
If you want to split 
a clip on one track 
without affecting the 
tracks above or below 
it, select the Razor 
tool  and click the 
clip in the Timeline 
instead.
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Effects! — Transitions, Special Effects & More 
Adobe Premiere Elements 2.0 comes fully stocked with a wide variety of special effects you can use 
simply by dragging to the Timeline, including transitions, filters to improve video quality, artistic 
effects and much more. For more advanced creative control, you can also fine tune them in the new 
context-sensitive Properties panel.

Instant effects

Locate the Effects and Transitions panel, and double-click Video Transitions to reveal the options 
inside it. Then double-click the Dissolve entry, and click the Cross Dissolve transition to activate 
the new thumbnail animation—this animation gives you a preview of the dissolve transition, 
before you apply it.
Drag the Cross Dissolve transition 
from the folder to the border 
between clips 01.avi and 02.avi on 
the Timeline. Release the mouse 
when the clip display highlights 
on both sides and the Insert 
Transition cursor  appears. 
Drag the playhead back towards the end of the first clip and press the spacebar to view the new 
transition.
Move back along the Timeline and 
play clip 33.avi—a shot of the two kids 
pretending they’re swimming through 
the tunnel at the aquarium. Let’s have 
some fun with this shot.
Returning to the Effects and 
Transitions panel, open the Distort 
set inside the Video Effects set, and 
drag the effect Wave Warp to clip 
33.avi on the Timeline. When the clip 
highlights, release the mouse button to 
apply the effect.
Drag the playhead back to the 
beginning of the clip and play it again 
to see the difference. The warping of 
the clip lends a comical “underwater” 
flair to the kids moving through the 
tunnel. 
Optionally, make sure the clip 
is selected on the Timeline, and 
adjust the settings for the warp in 
the Properties panel (see Take 2—
Advanced fun with special effects on 
page 8).

1 

2 

� 

� 

� 

� 

Experiment freely — the 
History palette keeps track of 
your editing steps and allows 
you to easily step backwards 
and forwards through them.
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you to easily step backwards 
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Drag transitions to the Timeline to apply them between clips. Once 
inserted, the transition shows above the clip and the Tool Tip will 
display its properties. Use the “­­­­–” and “+” keys to zoom in and out 
on the Timeline, or the backslash “\” to show all your clips at once.

Drag transitions to the Timeline to apply them between clips. Once 
inserted, the transition shows above the clip and the Tool Tip will 
display its properties. Use the “­­­­–” and “+” keys to zoom in and out 
on the Timeline, or the backslash “\” to show all your clips at once.

The Effects and Transitions panel contains hundreds of presets, 
transitions and effects you can simply drag to the Timeline.
The Effects and Transitions panel contains hundreds of presets, 
transitions and effects you can simply drag to the Timeline.

Want to create the 
same “fade in” or 
“fade out” you see in 
Hollywood movies 
at the theater? Select 
the first clip on the 
Timeline, right-click, 
and choose Fade > 
Fade in Video.

If you have a 
supported graphics 
processor, you’ll find  
GPU Effects in the 
Video Effects folder, 
and GPU Transitions 
in the Video 
Transitions folder. 
These leverage your 
graphics processor’s 
power to create 
stunning three-
dimensional page 
curl effects, and 
more. Try the Card 
Flip transition to 
create some “oohs” 
from your audience!
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Take 2—Advanced fun with special effects

The unique presets in the Effects and Transitions panel let you create in seconds the same kind of 
eye‑popping effects that once took weeks to accomplish. But Adobe Premiere Elements 2.0 also gives 
you the creative control that means precision creation and adjustment of every moment of your video. 
Once you create the custom effect you like, you can even save the settings as a new preset, and easily 
call it up to use again whenever you choose. 

Scroll back to 33.avi if necessary, and click to select 
it on the Timeline. The Properties panel now shows 
you the attributes of the clip, including the Wave 
Warp effect that you just applied. 
Click Show Keyframes in the Properties panel to 
reveal the keyframe mini-Timeline, and click the 
disclosure triangle next to the Wave Warp entry to 
reveal all of its properties. Expand the Properties 
panel if necessary so you can see all the entries 
and the keyframe section. The Wave Warp effect is 
applied evenly to the entire clip. Let’s vary the effect 
through the clip so it comes in gradually and then 
disappears before the clip is done. 
Move the playhead indicator to the beginning of 
the mini-Timeline and click the Toggle Animation 
button  for the Wave Warp effect. This adds 
a keyframe for each aspect of the effect at the 
beginning of the clip.
Move the playhead about a fifth of the way into the 
clip, and click the Add Keyframe button  for  the 
Wave Height attribute. Move the playhead about 
four-fifths of the way through the clip and click 
the Add Keyframe button again. Finally, move the 
playhead to the end of the clip and click the Add 
Keyframe button once more. You should now have 
four keyframes spread through the clip for the Wave 

Height attribute, and the playhead indicator line should be on the last keyframe. If you moved the 
playhead inadvertently, click the Next Keyframe button  to move it back to the last keyframe.
Click the Wave Height value to select it, type “0” and press Return to save the new value. 
Click the Previous Keyframe button  three time to move back to the first keyframe, then click 
the Wave Height value, type “0” and press Return to save the new value.
In the main project Timeline, move the playhead back a few seconds before the start of clip  
33.avi and press the spacebar to play the Timeline. 

Note that as 33.avi begins, there is no warp visible. As time progresses to the first keyframe, the effect 
appears, then disappears between the third and fourth keyframes. By adding keyframes and varying 
their values, you can precisely control the animation of any effect over time, and even of individual 
attributes of each effect. From the simplest effect to the most complex, the Properties panel gives you 
the ability to control your special effects with precision and flair.
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About Keyframes
Each keyframe 
stores the settings 
for an effect at 
that point in time. 
Premiere Elements 
automatically 
adjusts the effect 
settings between 
the keyframes, to 
create a smooth 
transition between 
them.
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Take command of effects with the Properties panel:

Click the “eye” icon to enable or disable an effect.
Control each effect attribute individually.
Left to right: Move to previous keyframe, add or delete keyframe, 
move to next keyframe.
Click to reveal or hide keyframes.
Zoom the mini-Timeline in or out for more or less detail.
Click to enable or disable time-based effect animation.
Drag a keyframe left or right to change its position in time.
Drag at the boundaries of the panel to resize it larger or smaller.
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Make it sound as great as it looks

Some video applications basically treat your soundtrack 
as an afterthought—if it’s there, you can hear it, but don’t 
try to do much with it. In Adobe Premiere Elements 2.0, 
your audio is treated with the same respect—and with 
the same extensive features—as is your video.

In the header area to the left of the clips, move the 
Selection tool to the boundary between the Audio 1 and 
Audio 2 tracks, and drag downward when the cursor 
shows the horizontal I-beams . The taller the track, 
the more of the audio waveforms you can see in the 
Timeline, and that visual indicator makes it simpler to 
trim and adjust your audio, or when you want to cut your 
video to the beat of a music track.
Scroll the Timeline to 27.avi. Open the Music folder in the 
Media panel, and drag the sound file caribbean_beat.wav 
to the blank area at the bottom of the Timeline. Premiere 
Elements 2.0 automatically creates a new audio track to 
contain the music 
file. Drag the 
music file so that 
it starts just before 
27.avi.

Right-click the caribbean_beat.wav file on the Timeline, 
and choose Fade > Fade in Audio. Two keyframes are 
automatically added, set to gradually fade in the music.
Scroll the audio section of the Timeline up, if necessary, 
so you can see the Audio 1 track—this is the audio for 
your Video 1 track clips. Drag the volume control line for 
Audio 1 down, to lower the volume under the music track.
(Optional) Instead of lowering the volume for the entire 
clip, move the playhead at the beginning of 27.avi and click 
the Add Keyframe button  to add a keyframe. Then move 
the playhead about a second into the clip and click the Add 
Keyframe button to add a second keyframe.
Drag the second keyframe down to create a fade the audio 
of the main video track out as the audio from the music 
track fades in.
Play the Timeline starting just before clip 27.avi to hear the 
results of your audio adjustments.
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Audio tracks on the Timeline

Audio 1— sound from your Video 1 track.
Drag between tracks to make them taller, for easier view of 
waveforms that help you cut your videos to the beat, or to locate 
bad sound you want to trim.
Click to add a keyframe at the playhead, for easy audio 
adjustments in a single clip.
Drag the keyframe to set the adjustment.
Add extra tracks for music, narration or ambient sound, up to 99 
in a single video.
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Dolby 5.1 audio 
will be converted 
to Dolby stereo on 
import. Premiere 
Elements 2.0 will 
not import Dolby 
Professional audio 
from protected 
sources such as 
Hollywood DVD 
movies.

Fine tune audio parameters and effects 
in the Properties panel.
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Creative Credits
Add exciting titles and credits to your video in seconds. Adobe Premiere Elements 2.0 comes loaded 
with even more themed templates—just add text to use them as they are, or customize them as you 
like, then save your own title styles for future use. 

Move the playhead to the middle of clip 
46.avi, just as the kids are about to eat 
the cotton candy.
Click the Titles button in the 
navigation bar to switch to the Titles 
workspace and bring up the Titler 
panel and title Templates window. 
These professional-designed templates 
jumpstart your creation of Hollywood-
style titles, and the Titler is your key 
to highest-quality results, with crisp, 
beautiful text that’s always a pleasure 
to read.
Open the Comicbook folder inside the 
General folder in the Templates window, select Comicbook_Lower3rd and click OK.

Note: The video displayed in the Titler panel is the frame which is at the playhead when you start a 
new title, and is only there as a background while you are building your titles. The actual video which 
plays under the title is determined by where the title is finally placed on the Timeline, as shown in the 
Monitor panel.

1 

2 
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Title templates in 
Adobe Premiere 
Elements 2.0 are 
matched to DVD 
menu templates, 
making it easy to 
give your video a 
coordinated theme 
from start to finish.

Title templates in 
Adobe Premiere 
Elements 2.0 are 
matched to DVD 
menu templates, 
making it easy to 
give your video a 
coordinated theme 
from start to finish.

You no longer 
have to choose 
a destination to 
save titles—they 
are automatically 
saved within the 
project file and are 
accessible in the 
Media panel.

You no longer 
have to choose 
a destination to 
save titles—they 
are automatically 
saved within the 
project file and are 
accessible in the 
Media panel.

Start with a template, then add your own text and additional graphics. Choose a preset text style or build your own. 
Even use the familiar built-in graphic, text and alignment tools to make it your own. From easy templates to titles 
from scratch, the Adobe Premiere Elements 2.0 title engine makes professional quality titles and credits a snap.

Start with a template, then add your own text and additional graphics. Choose a preset text style or build your own. 
Even use the familiar built-in graphic, text and alignment tools to make it your own. From easy templates to titles 
from scratch, the Adobe Premiere Elements 2.0 title engine makes professional quality titles and credits a snap.
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Click the Horizontal Text tool  in the tools panel to select it, then click inside the sample text 
with the Edit Text cursor  showing, and drag to select the sample text. Type “SNACK TIME!” to 
replace the first text block, then select the second block of text and type “Dining on the pier.” 
You can use the template as it is, or easily adapt it as extensively as you choose:

Click in the window when the New Text cursor  is displayed to create a new block of text. 
Click a sample in the Titler Styles panel to use a text style preset, or change the font and font 
styles, click the More button in the panel, and save a new style. 
Create or import graphics, including photos. 

Note: Be sure to keep your title text inside the pale rectangles near the edges of the window. These are 
the action-safe and title-safe boundaries, and you should never let your text spill over the lines.

When you have the title set up to your liking, locate it in the Media panel, and give it a new 
name that is more meaningful. You can then click the New Title  button in the Titler panel to 
start another title based on the first, or click the Titles button in the navigation bar to pick a new 
template for the next title.

Note: There’s no need to manually save the 
titles you create in Premiere Elements 2.0 
—they are automatically saved for you in 
the Media panel.

When you’re done creating new 
titles, click the Edit button in the 
navigation bar to switch back to the 
Edit workspace, find your new title 
in the Media window, and drag it to 
the Video 2 track, directly above the 
clip over which you want the title to 
appear.
Right-click on the title clip, and choose 
Fade > Fade In Video. Note that 
Opacity keyframes are added, and the 
yellow control line running through 
the clip on the Timeline shows the 
opacity increasing from transparent 
to opaque at the beginning of the 
clip. If you want to make the fade-in 
take longer, you can drag the second 
keyframe to the right. To make it 
shorter, drag the keyframe to the left. If you’d rather have the title come in with a more stylized 
transition, drag one from the Video Transitions folders in the Effects and Transitions panel. Just 
drop the transition onto the front of the title clip, and then adjust it in the Properties panel.
Move the playhead back to the start of the clip and press Play to see the new title over the video.
If you want to try creating some rolling credits for the end of your video, choose a new credits-
type template and start a new title. Then click the More button and choose Roll/Crawl Options. 
Enter options for timing and direction and click OK.

� 

� 

•
•

•
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What’s in a name? Choose 
your title fonts visually, with 
a preview of each typeface in 
the Font menu.

What’s in a name? Choose 
your title fonts visually, with 
a preview of each typeface in 
the Font menu.

A

B

DC
Adding and adjusting titles on the Timeline

Drag titles to the Video 2 track to superimpose them 
over your main video.

Your main video is usually on the Video 1 track, but 
you can layer video, still photos and titles on other 
video tracks, for picture-in-picture effects as well as 
superimposed titles.

Use keyframes on the Timeline to control changes in 
effects over time.

Drag the control line up or down to increase or 
decrease an effect for the entire clip. The effect 
being controlled is indicated in the clip’s title 
bar—in this case, opacity.

A 
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Adding and adjusting titles on the Timeline

Drag titles to the Video 2 track to superimpose them 
over your main video.

Your main video is usually on the Video 1 track, but 
you can layer video, still photos and titles on other 
video tracks, for picture-in-picture effects as well as 
superimposed titles.

Use keyframes on the Timeline to control changes in 
effects over time.

Drag the control line up or down to increase or 
decrease an effect for the entire clip. The effect 
being controlled is indicated in the clip’s title 
bar—in this case, opacity.
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Creating DVDs
Some applications require additional software to create DVD menus and burn your videos to disc, 
but not Adobe Premiere Elements 2.0, your one-stop movie-making shop. Simply click the DVD 
button on the navigation bar to open the simple, step-by-step DVD menu creation system.

Click the DVD button on the 
navigation bar to open the DVD 
Templates panel. With the Apply 
a Template for a DVD with Menus 
radio button enabled (try saying that 
three times fast), open the Theme 
pop-up menu and choose Travel.
Click on the Blue Sky theme to select 
it, and then click OK.

Note: If a warning appears about missing 
DVD markers on the Timeline, just 
click Yes, then OK in the next dialog 
to let Adobe Premiere Elements 2.0 
automatically create scene menu buttons 
at the start of every scene on the Video 1 
track. You can adjust scene markers later by double-clicking them on the Timeline. 

Drag the boundary between the DVD Layout panel and the Timeline panel downward for a larger 
preview of your layout (you won’t need to see the Timeline much at the moment). Then drag the 
top boundary of the Properties panel up until it is as tall as possible—you will use the controls in 
this panel to adjust your menu elements.

In the DVD Layout window, double-
click the Headline Title and change 
the text to “San Francisco Daze.” To 
make sure you’re staying to the safe 
zone, click the More button at top 
right and choose Show Safe Margins. 
If your title crosses the lines, drag the 
sizing boxes at either end inward, and 
use the Properties panel to adjust the 
font and font sizing. 
Click the background area to select 
it, then open the Video folder in the 
Media panel. Drag the clip 03.avi into 
the DVD Layout window background 
to create a looped, full-motion 
background. Note you can adjust 
where in the clip the background 
video starts, by dragging across the In 
Point time display in the Properties  
panel.
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Premiere Elements 2.0 comes with dozens of themed DVD 
template sets, including main and scene menus for every 
occasion. Use them as they are, or personalize them to suit 
yourself, with full motion backgrounds and menu buttons, 
and custom soundtracks.

Premiere Elements 2.0 comes with dozens of themed DVD 
template sets, including main and scene menus for every 
occasion. Use them as they are, or personalize them to suit 
yourself, with full motion backgrounds and menu buttons, 
and custom soundtracks.

A B
Click the DVD Marker 
button (A) to create 
a scene marker (B) 
at the playhead, 
which will be used to 
automatically create 
scene menu buttons 
on your DVD.

A B
Click the DVD Marker 
button (A) to create 
a scene marker (B) 
at the playhead, 
which will be used to 
automatically create 
scene menu buttons 
on your DVD.

Easily create personalized DVD menus, complete with custom audio and full motion backgrounds 
and menu buttons. Click to select an element in the DVD Layout panel, then adjust the settings 
for the element in the context-sensitive Properties panel.

Easily create personalized DVD menus, complete with custom audio and full motion backgrounds 
and menu buttons. Click to select an element in the DVD Layout panel, then adjust the settings 
for the element in the context-sensitive Properties panel.
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Open the Music folder in the Media panel, locate fun_music.wav, and drag it to the Audio section 
of the Properties panel, in the square marked Drag Media Here.  Then make sure the Apply 
Default Transition before Loop check boxes are enabled in both Video and Audio sections.

Note: You can click Apply to All Menus to repeat the current background images, audio and settings 
across all of the scene menus, and also set the duration for the loop and for Motion Menu buttons. 

Click Scenes Menu 1 in the lower box to switch to the first scenes menu. Click the first button to 
edit the scene marker settings in the Properties panel—be sure the Motion Menu Button check 
box is enabled to create full-motion scene menu buttons. You can also click the Edit button next 
to the Scene Marker label to edit 
the button text, and otherwise edit 
the text and motion settings as you 
did in step 5 for the Main Menu.
Once satisfied with your menus, 
click Preview DVD to open the 
Premiere Elements 2.0 DVD 
simulator. Test out the buttons 
for your pending disc by running 
through the navigation with 
an interface that mimics the 
remote control of a standard 
home DVD player. You can then 
go back to the Timeline to add 
or remove markers, or back to 
the Layout panel to adjust the 
menus themselves. If you have a 
TV attached through your DV 
camcorder, you can even preview 
your DVD on your TV, just as it 
will appear in the finished disc.

Once you’re happy with the simulated DVD, it’s time for the real thing. 
In the Layout window, click Burn DVD. In the Burn DVD window, you 
can name your disc, choose a burner if you have more than one, and 
set the number of copies you want to burn. Under Quality Settings, you 
will probably always want to leave the “Fit Contents to available space” 
check box enabled—Adobe Premiere Elements 2.0 will automatically 
use the highest possible encoding quality for the size of your single- or 
dual‑layer DVD media. Finally, if you’re creating a DVD for viewing in 
the Americas or Japan, leave the NTSC radio button enabled. If you need 
to burn in PAL format for viewing in Europe and other countries in Asia, 
click the radio button to the right instead.
Insert a blank DVD in your burner and click Burn to start the process. 
Depending on the size of your video and media, this may take a while, so 
it’s best to set up to burn your video when time isn’t pressing.

� 

� 

� 
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Be confident your DVD movie will work exactly as you expect—
before you burn the disc. Test out your motion menus and 
buttons with full sound playback and virtual remote control in 
the Preview DVD window. 

Be confident your DVD movie will work exactly as you expect—
before you burn the disc. Test out your motion menus and 
buttons with full sound playback and virtual remote control in 
the Preview DVD window. 

New dual-layer 
DVD support 
allows for up 
to four hours 
of video on a 
single, 8.5 GB 
disc. New Dolby 
audio support 
compresses 
the soundtrack 
tighter than ever 
before, while 
maintaining high 
stereo fidelity—
leaving more 
room for more 
minutes of higher 
quality video. 
Together you get 
bigger, better 
home movies 
with Premiere 
Elements 2.0.

New dual-layer 
DVD support 
allows for up 
to four hours 
of video on a 
single, 8.5 GB 
disc. New Dolby 
audio support 
compresses 
the soundtrack 
tighter than ever 
before, while 
maintaining high 
stereo fidelity—
leaving more 
room for more 
minutes of higher 
quality video. 
Together you get 
bigger, better 
home movies 
with Premiere 
Elements 2.0.

The Burn DVD window lets you burn to single- or 
dual-layer DVD discs, in NTSC or PAL formats, with no 
additional software required. Plus, video quality is 
automatically optimized for the available disc space.
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Save or Move your Video Project
Your video project can comprise hundreds of files and 
gigabytes in file size. Premiere Elements 2.0 makes it easy to 
move the most complex video project to another computer, 
or to create a streamlined backup you can come back to and 
re‑edit at any time.

Choose Project > Project Archiver.
In the Project Archiver window, click Browse to choose a 
destination for the archive, and select either Archive Project 
or Copy Project. 

The difference is simply that a project Copy includes all the 
media in your Media panel, regardless of whether it’s used on 
the Timeline or not. An Archive project includes only the media you have actually placed on the 
Timeline. Use Copy Project when you want to move an entire video project in progress to a different 
computer with all files intact. Use Archive Project to maintain a backup of a finished video in a state 
that is always re-editable.

Get Help when You Need It
Adobe Premiere Elements 2.0 makes it easy to create great videos, and provides handy resources 
to learn how to make the most out of every movie project. The context-sensitive How To panel 
keeps tips at your fingertips as you use every feature. Click the Tutorials button in the Welcome 
Screen for included, self-guided lessons. And choose Help > Premiere Elements Help for in-depth 
documentation in Adobe Help. We hope you enjoy your new movie-making world, and for now, 
that’s a wrap!

Adobe Photoshop Elements 4.0 Plus Adobe Premiere Elements 2.0
Edit, organize and show your photos with Photoshop Elements 4.0. Enjoy simple, powerful video 
editing and DVD creation with Adobe Premiere Elements 2.0. Now, enjoy the power of both together 
in one affordable, convenient package. Easily open Premiere Elements DVD menu templates 
in Photoshop Elements for editing, or create new ones from scratch to use over and over again. 
Whether you’re adding still photos to your latest video, turning video frames into great photo 
creations, or creating standalone DVD slide shows from your photos, you can do even more using 
these two great products together. Best yet—save money! The Adobe Photoshop Elements 4.0 Plus 
Adobe Premiere Elements 2.0 bundle debuts at the suggested retail price of just $149.99, a $50 savings 
over purchasing the individual products.

About Adobe Systems Incorporated
Adobe helps people and businesses communicate better through its world-leading digital imaging, 
design and document technology platforms for consumers, creative professionals and enterprises. 
Adobe’s revenue in its last fiscal year exceeded $1.2 billion. For more information about Adobe, visit 
www.adobe.com.
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Minimum System 
Requirements
Windows®
•	 Intel® Pentium® 4, M, D, or 

Extreme Edition; or AMD 
Opteron or Athlon 64 (SSE2 
support required)

•	 Microsoft® Windows® XP 
Home Edition, Professional,  
or Media Center, with  
Service Pack 2

•	 256 MB of RAM 
•	 4 GB of available hard  

disk space
•	 DVD-ROM drive (compatible 

DVD burner required to burn 
DVDs)

•	 1024x768, 16-bit XGA display
•	 Microsoft DirectX 9 compat-

ible sound and display drivers
•	 DV/i.LINK/FireWire/IEEE 1394 

interface to connect a Digital8 
or MiniDV camcorder; or a 
USB2 interface to connect a 
DV-via-USB-compatible DV 
camcorder (other video  
devices supported via the 
Media Downloader) 

Estimated Street Price
$99 (U.S.) 

Expected Availability
Fourth Quarter 2005
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